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Introduction 
 

  WSD (Wave Sound Decorator) is application software designed for the use in mobile terminals with 
MA2/MA-3/MA-5/MA-7 that supports SMAF playback. It contains “simplified waveform editing function” etc. 
as well as “PCM-to-SMAF conversion function.” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Recommended Operating Environments 
 

The recommended operating environments of WSD are as follows.  
 

Supported OS Microsoft® Windows® XP 
Microsoft® Windows® 2000 

CPU/Clock Pentium 4® 2.0GHz or faster; Or the other compatible processor 
Memory 256MB or more 
Required HDD Space 40MB or more 

 
【Note】 All product names used in this manual are trademarks and registered trademarks of their respective 

companies. 
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Revision History 
 
 
Version Date of issue Description 

1.0.0 2005/1/20  Newly Released 
Recommended 
Operating 
Environments 

Pentium III 800MHz  Pentium 4 2.0GHz 
Memory 128MB  256MB 

2. Added MA-7. 
3.2. Added MA-7. 

Deleted confirmation message for sampling frequency which 
exceeds frequency limits. 

3.3.3. Added MA-7. 
3.3.6. Added supported frequency of 44100 and 32000Hz 
3.3.8. Added MA-7. 

1.1.0 2005/10/19 

4.1.1. Added MA-7. 
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1. Preparation for Use 
 

  This chapter describes a series of operations to install the WSD into your computer. Be sure to follow the 
steps shown below and correctly install the WSD into your PC. 
 

 
 
 
1. Double-click “Setup.exe” to start “Setup Wizard.” 
 
 
 
 
 
2. Select any folder to install the WSD, and then press “Next.” 
 
 
 
 
3. “Confirm Installation” dialog is displayed. 

Click “Next” button to start the Installation. 
 
 
 
 
4. When the installation is completed, “Installation Complete” dialog 

will be displayed. 
   Click “Close” button. 
 
 
 
 
5. A shortcut of the WSD is created on your desktop and start menu. 

Click the created short-cut icon to start the WSD. 
 
  
  
  
  
 
 

2. Input/Output Condition 
 

Input/output restrictions of WSD are listed as follows. 
WAVE-to-SMAF conversion beyond the following ranges cannot be supported. 
  

  
Input File 

WAV [*.wav], AIFF [*.aif, *aiff] 
 Output File 

SMAF [*.mmf] 
Bit Channel Sampling Frequency  File Format Channel Sampling Frequency

    SMAF/MA-2 Mono 4kHz or 8kHz 
8bit or 16bit Mono or Stereo 4kHz to 48kHz  SMAF/MA-3 Mono 4kHz to 16kHz 

    SMAF/MA5 Mono 4kHz to 24kHz 
     Stereo 4kHz to 12kHz 
    SMAF/MA7 Mono 4kHz to 48kHz 
     Stereo 4kHz to 24kHz 
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3. Let’s use WSD 
 

  This chapter describes a series of operating procedures from the loading procedure of a WAV-file (*.wav) or 
AIFF-file (*.aif, *.aiff) to the saving procedure as a SMAF-file (*.mmf).  

 
 
 
 
 
 
3.1. Configuration of User Interface 

 
  The following is the main window of the WSD. This window is designed so that a series of operation can 
be performed. For details of each function, see the later part in this document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Function Name Description 
1 Title Bar Displays this application name or a file name loaded into the WSD.  

(For details, see p.7) 
2 Menu Bar Opens “File Menu,” “Edit Menu,” “View Menu,” or “Help Menu.”  

(For details, see p.8) 
3 Tool Bar A series of performance such as WSD operating environments setting, file opening and 

file saving, and wave file playback can be executed.  
(For details, see p.10) 

4 Waveform View Displays a waveform of a loaded WAV file (*.wav) or AIFF file (*.aif, *,aiff). If monophonic 
data was loaded, one waveform is displayed. And, if stereo data was loaded, two 
waveforms are vertically displayed: upper waveform for L channel and lower waveform 
for R channel. (For details, see p.11) 

5 Status Bar Displays the status of loaded audio data. 
(For details, see p.11) 

 

2 
3

4 

5 
Application Window

1 
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3.2. Let’s convert WAV file/AIFF file into SMAF file  

 
  This section describes a series of operation from the load operation of a WAV file (*.wav) or AIFF file (*.aif, 
*.aiff) into WSD to the saving operation as a SMAF file (*.mmf). For details of each procedures and functions, 
see the later part in this document.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. WSD application window is displayed on your desktop. 
For details about this application window, see p.5. 

5. If a data loaded into WSD is stereo, two waveforms are 
vertically displayed in two levels. And, in case of monaural, 
one waveform is displayed in one level.  
For details, see p.11 

4. A music data was loaded into WSD. Based on the 
specifications of the objective content, change the settings of 
target selection box and Sample Type.  
For details about each input/output condition, see p. 4 

Stereo 

1. Start up WSD by selecting in order of 
Start Program YAMAHA WSD or by double-clicking a 
shortcut icon “WSD.exe” created on the desktop.  

3. Load a WAV file (*.wav) or AIFF file (*.aif, *.aiff) into WSD 
by directly dragging and dropping the file onto Application 
Window or by opening it from Menu Bar File Menu 

Open. 

Mono 

There are restrictions such as usable frequency 
range, usable channel numbers, etc. on the 
specification of each mobile synthesizer 
(MA-2/MA-3/MA-5/MA-7). So, before you start 
creating your contents, we strongly recommend 
you to refer to WSD: Sample Type Spec 
Sheet…, or Input/Output Condition in this 
document for your understanding.  

6. A loaded data can be modified into the desired form by using 
functions in Menu bar, such as Normalize, Trimming, Fade 
In, Fade Out, and Sample Type. In addition, WSD can not 
only convert all the loaded data but select a part of data by 
using the dragging function of mouse. When selected, 
waveform information of the selected area is displayed on 
Status bar. (Only playback of the designated part can be 
performed, but it cannot be saved. Perform “Designate a 
range by using mouse”  “Trimming”  “Save,” to save the 
selected part.  

7. Give a name to the edited file and save it in SMAF Format 
(*.mmf). 
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3.3. General Outline of Function 

  
 This section describes the functions, general outlines, names, etc. which are provided in WSD. 

 
 
 
 
3.3.1 Title Bar 

 
 The Title Bar shows the application name “WSD” and the name of a file that is currently opened in WSD. 
The details of each function are described in the following table. 

 
 
 
 
 
 
 
 

No. Function Name Description 
1 System Icon By clicking this icon, System menu is opened.  
2 Minimize button By clicking this button, the window is minimized. 
3 Maximize/Undo (minimize) button By clicking this button, the window is maximized. In a condition of 

which the window has been maximized, when this button is pressed 
once again, the window is restored to its original size. 

4 Close button By clicking this button, the window is closed. 
 
 
 
 
 
3.3.1.1 System Menu 

 By clicking the “System Icon” located on the left end on “Title Bar,” this “System Menu” is opened. 
Functions provided in this menu are described in the following table. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Description 
1 Restore (R) Restores the window being displayed to the original 

size. 
2 Move (M) Changes the mouse pointer into a moving tool.  
3 Size (S) Changes the mouse pointer into a size-change tool. 
4 Minimize (N) Minimizes the window. 
5 Maximize (X) Maximizes or reduces the window. 
6 Close (C)   Alt+F4 Closes the window being opened. 

1 
2 
3 
4 
5 

6 

31 2 4
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3.3.2 Menu Bar 

  
  The following functions are provided in Menu Bar to execute various operations. For details about each 
function, see the sections for each function. 
   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.2.1 File Menu 
  A series of operations such as Open, Save, and Exit of a file can be performed with this menu. 
 
 
 
 
 
 
 
 
 
 
 
 
【Note】 When “Exit” is executed while a file being opened on the WSD is not saved after editing, a save 

confirmation dialog will be displayed. 
 

 
 

3.3.2.2 Edit Menu 
 In Edit Menu, various editing functions (Normalize, Trimming, Fade In, and Fade Out) are provided. 

 
 
 
  
 

 
 
 

 
 
 
 
 
 
 
 
 

No. Function Name Description 
1 Open…(Ctrl+O) Displays “Open…” dialog and reads a file selected in there. A 

format of WAV (PCM) [*.wav] or AIFF [*.aif, *aiff] is supported. 
2 Save (Ctrl+S) Converts a file loaded in WSD into a SMAF and saves it on the 

file. 
3 Save As… Displays a “Save As…” dialog and converts a file into a SMAF 

and saves it. 
4 Exit Exits from this application. 

No. Function Description 
1 Select All (Ctrl+A) Makes the whole waveform a selected state. 
2 Normalize The waveform is extended to the amplitude axis direction by 

normalizing the maximum sample within the selected range as 
0dB (100%). Waveform view will be updated after “Normalize” is 
processed. 

3 Trimming Deletes all unselected range. The selected range is resized 
(maximized) after "Trimming" is completed. 

4 Fade In This sound effect that gradually increases volume is given by 
taking the first part of the selected range as 0% and taking the 
end part of that as 100%. The contents on the window will be 
updated after “Fade In” was processed. 

5 Fade Out This sound effect that gradually decreases volume is given by 
taking the first part of the selected range as 100% and taking the 
end part of that as 0%. The contents on the window will be 
updated after “Fade Out” was processed. 

6 Sample Type… Displays “Sample Type…” dialog. (See, p.12) 

Help Menu 
(see, p.10) 

View Menu 
(see, p.10) 

Edit Menu 
(see, p.8) 

File Menu 
(see, p.8) 

1 
2 
3 

4 

1 
2 
3 
4 
5 
6 
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Example (Normalize, Trimming, Fade In, Fade Out) 
  This section describes the details about four types of editing functions which are provided from Edit Menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This is a state of which a new WAV (PCM) [*.wav] or AIFF [*.aif, 
*aiff] file was loaded into the WSD. A waveform of the loaded 
data is displayed on View Window. 

Fade In 
gives an effect that gradually increases 
volume by taking the first part of the selected 
range as 0% and taking the end part of that 
as 100%.

Fade Out 
gives an effect that gradually decreases 
volume by taking the first part of the selected 
range as 100% and taking the end part of 
that as 0%. 

Normalize 
extends the waveform to the 
amplitude axis direction by 
normalizing the maximum sample 
within the selected range as 0dB.

Trimming 
 

Deletes all the unselected range. 

Select All 
Makes the whole waveform a selected state. 

Range Selection 
 

Selects only arbitrary part from the loaded 
WAV or AIFF file by using a mouse. 

Before executing a “Trimming” function, first of all, select a 
part of the loaded data (WAV, AIFF) first by using the 
mouse as shown below. In a state of which any range has 
been selected, select Menu bar, Edit Menu, and Trimming 
in this order.

Partial selection 
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3.3.2.3 View Menu 

The View Menu provides functions to change the scaling. 
  

 
 
 
 
 
 
 
 
 
3.3.2.4 Help Menu 
  The Help Menu provides the following functions to support user’s operations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.3 Tool Bar 

The Tool Bar contains functions for data playback and playback stop as well as the functions which are 
provided in “File Menu”, “View Menu”, etc. For details about each function, see the following table. 

 
 
 
 
 
 
 
 
 
 

No. Function Name Description 
1 Target Selection Combo Box Switches the types of SMAF to output: MA-2/MA-3/MA-5/MA-7. 
2 Open button Opens a WAV (PCM) file or AIFF file. 
3 Save button Saves a loaded WAV (PCM) file or AIFF file in SMAF file format (*.mmf). 
4 Zoom In button Magnifies the waveform display magnification to the time axis direction by one 

step. 
5 Zoom Out button Reduces the waveform display magnification by one step.  
6 Play button Converts a displayed wave data into SMAF format and plays it back. When a 

part of the loaded wave data is selected, only that part is played back. 
7 Stop button Stops the playback of music. 
8 Information button Displays “Contents Information dialog.” (See, p.13) 

 
 
 
 

No. Function Name Description 
1 Zoom In Magnifies the waveform display magnification to the time axis 

direction by one step. 
2 Zoom Out Reduces the waveform display magnification by one step.  

No. Function Name Description 
1 Sample Type Spec Sheet… Displays “Sample Type Spec Sheet (PDF).” 
2 About WSD… Displays “About WSD…” (See, p.12)  

1 
2 

1 
2 

1 2 3 4 5 6 7 8 
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3.3.4 Status Bar 

 The Status bar shows a state of waveform data that has been loaded in WSD. For details about each 
function, see the following table. 

 
 
 
 
 
 
 

No. Function Name Description 
1 Starting Position Display  A playback starting position is displayed in time when a range was 

selected on a waveform. 
2 End Position Display A playback end position is displayed in time when a range was selected on 

a waveform. 
3 Selected Range Display Displays the selected waveform range (Start  End) in time. 
4 File Size Display Displays an indication of the file size when a waveform data being opened 

on WSD is converted into SMAF and is output under the present settings. 
It is displayed in KB. (1KByte = 1024Byte) 

5 Sample Type Display Displays the sample types (sampling frequency, quantized bit number, 
Channel number) of the displayed waveform data. 

 
 
【Note】 The file size is displayed only when a file can be saved as a SMAF. 
 
 
 
 
 
3.3.5 Waveform View 
 A loaded waveform data is visually expressed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Description 
1 Waveform Display Opens a loaded data and displays its waveform. When a data loaded into WSD 

is stereo, two waveforms are vertically displayed: Upper level for L channel and 
lower level for R channel. And, in the case of monaural, a waveform is 
displayed.  

2 Level Scale  Displays the scale of time axis direction. 
3 Vertical Scale Displays the scale of amplitude axis direction. 
4 Playback cursor Shows whereabouts a playback position is located. 

 

1 2 3 4 5 

1 

2 

3 

4 
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3.3.6 Sample Type Dialog 

With this dialog, a sample type of the loaded waveform data can be converted into an arbitrary form. 
Re-sampling and conversion from stereo to mono can be performed. 

 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Description 
1 Resample On/Off By placing a check, sampling is enabled again. 
2 Resample Combo Box Displays a selectable frequency. Only conversion to the lower frequency than 

the waveform data frequency opened in WSD is possible. The selectable 
frequencies are as follows.(44100, 32000, 24000, 22050, 16000, 12000, 11025, 
8000, 4000 Hz) 

3 Convert to Mono On/Off By placing a check, stereo data can be converted into mono. 
The mixing is performed under the following condition: L: 50% ,R:50% 

 
 
【Note】 Keep in mind that tone quality is deteriorated if re-sampling is repeated. 
 
 
 
 
 
 
 
3.3.7 About WSD Dialog 
  The tool’s version information etc. are displayed. 
 
 

 
 
 
 

1 2 

3 
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3.3.8 Contents Information 
  The Contents Information of a SMAF to output can be set. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Description 
1 Copy Status Sets Enable/Disable of Editing, Save, and Transfer of a SMAF to output. 

When checked: Enabled  When unchecked: Disabled 
  Edit Enable/Disable of editing 
  Save Enable/Disable of save 
  Trans. Enable/Disable of transfer 
2 Code Type Character codes used for the contents information can be designated: Shift-JIS, 

Latin-1, EUC-KR, or UTF-8. 
3 Vender Name Vender Name 
4 Carrier Name Carrier Name can be entered. 
5 Category Name Category Name can be entered.  
6 Song Title Song Title can be entered.  
7 Artist Name Artist Name can be entered.  
8 Lyricist Lyricist can be entered. 
9 Composer Composer can be entered. 
10 Arranger Arranger can be entered. 
11 Copyright© Copyright can be entered. 
12 Management Group Management Group can be entered. 
13 Management Info. Management Info. can be entered. 
14 Creation Date Creation Date can be entered. 
15 Revision Date Revision Date can be entered. 
 

【Note】 With the contents for MA-3/5/7, the setting of “Edit,” “SAVE,” and “Trans” is available. And, with the 
contents for MA-2, the setting of “Save” and “Trans” is available. 

 
 

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 
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4. Supplemental Information 
 
 

4.1. Message List 
This section describes the messages displayed on WSD. 
 
 
 

4.1.1 Error Messages 
 
 
 

No. Error Message Cause 
1 Cannot open WAV / AIFF file File access error. Loading of a wave file is not permitted or a file is 

being used by other applications. 
2 Extension is not .wav / .aif / aiff A file other than WAV or AIFF was loaded, or the extension of a file 

is incorrect. 
3 Filename length exceeds limit The absolute path length of a file to load exceeds the limit of the 

character numbers. (when a file was dropped and when file name 
was designated in the Open dialog). Or, the absolute path length 
of a file that was designated as save destination exceeds the limit 
of the character numbers. (When file name was designated in the 
Save As … dialog). 

4 Audio format not supported Data does not meet neither WAV(PCM)format nor AIFF format. 
Data is broken or is WAV format other than PCM (such as ADPCM 
or MP3). 

5 Sampling Frequency not 
supported 

Audio data with a sampling frequency outside the range from 4kHz 
to 48kHz were input, or data save was attempted in the 
unsupported frequency. The supported frequency is as follows. 
- MA-2 → 4000Hz or 8000Hz 
- MA-3 → 4000Hz to 16000Hz 
- MA-5 → 4000Hz to 24000Hz(Mono) 

4000Hz to 12000Hz(Stereo) 
- MA-7 → 4000Hz to 48000Hz(Mono) 

4000Hz to 24000Hz(Stereo) 
6 Bits per sample not supported Audio data of the quantized bit numbers other than 8bit/16bit were 

input. 
7 Channel count not supported Audio data with a channel number other than 1(Mono) or 2(Stereo) 

were input, or data save was attempted in an unsupported channel 
number. The supported channel number is as follows. 
- MA-2/3 → Mono 
- MA-5/7   → Mono/Stereo  

8 Inadequate playback time One attempted to load a file of 20 ms or shorter of playback time. 
9 Playback time exceeds limit One attempted to save data with playback time beyond the 

limitation as a SMAF.  
- MA-2  →  66040 [msec] 
- MA-3/5/7 → 2097151 [msec] 

10 Cannot save SMAF file File access error. A SMAF file with the same name exists as Read 
only, or the writing to the folder itself is not permitted. 
Or, disk capacity is insufficient.  

11 Cannot open Sample Type 
Spec Sheet 

There is no WSD_SampleTypeSpecSheet.pdf. Computer’s 
environment for opening a PDF is not satisfied.  

12 Cannot Load DLL Cannot load either of M7_EmuSmw7.dll or M7_EmuHw.dll. 
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